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InfView Overview

InfView is a general purpose Windows file Viewer that works with Windows 3.1, Windows for Workgroups,
Windows NT and the OS/2 Windows environment.

InfView allows you to view up to 25 files at once in either formatted "Ascii" mode, in true "Ascii" mode, in a
"Hex/Ascii" format similar to Dos Debug, in a mode that attempts to extract only the "text" out of a file and
Image viewing that will display any 16/256 color Bitmap or PCX image.

Unlike other file viewers, InfView has NO practical file size limit; the only limit is set by Windows providing
memory to InfView to read and hold the file. InfView reads the entire file into its Window so that
displaying, searching and scrolling are instantaneous. The only time a file is re-read is when you switch
viewing modes (hex / ascii).

InfView will do string searches in Ascii View or string, hex or offset searches in the Hex View. There is a
one step Repeat Search menu item and keystroke to ease repeated searches through files.

InfView can do file or character searches across your disk or network and then build a Search List that
you can traverse and examine.

Since Infview can view multiple files at once, there are a host of multiple-file commands and keystrokes,
including file comparison routines that will look for differences in the files that you are viewing.

The Hex Editor option will allow you to modify files in their Hex mode. This is especially useful for poking
or modifying unreadable Binary files and this option will allow you to modify executable files as well!

InfView has a utility that will attempt to identify files based on either internal identifiers or on the file's
extension. Currently 50 different file types can be identified.

There is a menu option to execute the file that is being viewed. If the file being viewed is a Dos or
Windows program or Library, InfView will load and run that file, otherwise InfView will attempt to identify
the file and then will attempt to load the application that uses that file. In other words, if you are viewing
ABC.WRD the Execute command will load Word for Windows with ABC.WRD already loaded.

Though InfView was written for "Informer" - The Windows Personal Information Manager, it can be easily
be used with Windows File Manager and other Windows ultilities to ease file viewing operations.



IntelliLib (tm)
This program utilizes IntelliLib (tm) Library management technology.

IntelliLib enables this program to selectively use Windows Dynamic Link Libraries (DLLs) to perform non-
standard tasks. The user has the ability to choose which Libraries are loaded, thereby allowing him to
tailor this program to his specific needs.

IntelliLib also allows this program to fully operate without DLL modules that were expected. Functionality
for a missing Library is disabled from the main program.

Additional Topics:
InfView's DLLs

IntelliLib Setup



IntelliLib Setup

IntelliLib allows you to select which non-standard functions of a program are loaded at run-time. You
may modify your selections once they are made though the program will have to be restarted.

From the Options menu select the IntelliLib option. The Window that appears has several fields:

Load Bmp/Pcx Viewing Library - If you select this option you will be able to view all Bmp and Pcx
images.

Load Gif Viewing Library - If you select this option you will be able to view all Gif images.

Load File Compression Library - If you select this option you will be able to view list of files within Zip
and Lzh compressed data sets.

UnZip Path - Enter the path and program name (including extension) of your Unzip program. You can
use the Browse button to select the UnZip program from your local or network disk.

UnLzh Path - Enter the path and program name (including extension) of your UnLzh program. You can
use the Browse button to select the UnLzh program from your local or network disk.

Note: InfView uses the following command formats to extract programs from compressed data sets:
Zip - ProgramName.Ext FILENAM1.EXT FILENAM2.EXT
Lzh - ProgramName.Ext E FILENAM1.EXT FILENAM2.EXT
Where FILENAM1 is the file containing the compressed files and FILENAM2 is the selected file to extract.



Loading InfView

InfView can be loaded:

- As an Icon from a Program Manager group.

- From the RUN feature of Program Manager or other Windows Shell programs.

- From Windows File Manager or other File Management utilities using the Windows association table.
- Using Drag n Drop from any windows program with that capability.

If you have added InfView to a group within Program Manager (or other shells) you can load InfView by
Clicking on the Icon. This will cause InfView to load and to request a file selection from an "Open File
dialog.

If you use the RUN facility within Program Manager (or other shells) you can load InfView with no files in
its buffer by simply typing "INFVIEW" and pressing ENTER. This will cause InfView to load and to
request a file selection from an "Open File" dialog.

Note: The "Open File" dialog loads with the directory path of the file that was most recently loaded.
This allows you to progressively view files within a directory without having to locate the Directory each
time. If you select the "Cancel" button on the Open File Dialog, InfView will automatically load the last
file that you viewed.

Your final option for loading InfView is to have it automatically load with a file that is selected by Windows
File Manager or other File Management utilities. Windows File Manager maintains a table of file
extensions and programs in the WIN.INI file under the "Extensions" heading. If you want InfView to load
every time a file with the extension of "TXT" is selected by File Manager, you would add a line to WIN.INI
- Extensions showing: "txt=INFVIEW.EXE A.txt". For more information see the section on File Manager
in your Windows manuals.

Other File Management utilities have similar options to load file viewers - however you should consult the
documentation in order to determine the steps required in order to have InfView load automatically.

Additional Topics:

Loading from the Command Line
Loading using Drag and Drop



Loading from the Command Line

InfView can be loaded from any program that offers program execution from a Windows command line,
such as the RUN option within PROGRAM MANAGER.

InfView can accept up to 9 file names from the command line, each seperated by at least 1 space, ie:
"INFVIEW AUTOEXEC.BAT CONFIG.SYS TEMP.TXT". Each file name must be fully qualified with it's
path.

You can invoke some InfView functions from the Command line as well:
Compare - To invoke a compare of all loaded files, insert the "\¢" command anywhere within the

command line, ie: "INFVIEW WIN.INI WIN.BAK\C". Note: both \c and \C are accepted. As soon as ALL
files on the command line are loaded, InfView will start comparing ALL files being viewed.



Loading using Drag and Drop

InfView will accept files that are dragged from other Windows programs (such as File Manager) and then
dropped onto InfView. InfView must already be active as either an Icon or a Window in order for drag

and drop to work.

You can drag and drop any number of files into InfView. If the number of files exceeds InfView's
maximum number of files to be viewed at once, you will be asked whether you want to temporarily extend
the number of files to be viewed.



Saved Configuration (INFORMER.INI)

Each time you run InfView it automatically saves several options that will be used when you next invoke
InfView. They are:

Position: If you move or resize the InfView Window, the last position before you close InfView is stored.
When InfView is next invoked it will set itself to that last position. This option allows you ensure that
InfView loads to a particular area on your screen.

View Type: Whether the file you are viewing will be loaded initially in Ascii or Hex view type. (Menu option
View - sub-menu options Ascii View or Hex View).

Editing Characters: Whether editing characters will be shown in an expanded way, including Tabs,CR,
etc..(Menu option View - sub-menu options Do Not Expose or Expose).

Replace Non-Visible Characters: Whether non-visible characters will be replaced in the viewer with '~
(Menu option View - sub-menu option Replace Non-Visible).

Print Margins: The Margins you last set-up for printing from InfView. (Menu option Print)

Print Line Numbers: Whether or not your printed output has line numbers. (Menu option Print).

Print Page Numbers: Whether or not your printed output has page numbers. (Menu option Print).

Previously Viewed Files: InfView remembers the last 3 files that were viewed. They are listed under the
Files menu option and can be retrieved by selecting them directly from the menu.

Current Font: The currently selected font.

Current Font Size: The size of the currently selected font.

All of these options are saved in the INFORMER.INI file in your current or windows directory under the
heading of [InfView].

The configuration options that are saved in INFORMER.INI can be localized so that they can be
dependant on a particular calling program or they can be generalized for all applications by placing the
INFORMERL.INI in different directories.

To configure InfView specifically to a calling application, create (or copy) the INFORMER.INI file to the
Current directory from which InfView will be called. InfView searches for INFORMER.INI in the current
directory before looking in the Windows directory. If the file exists in the current directory it is used.

To configure InfView generally for all calling applications use the default INFORMER.INI file in the
Windows directory.

InfView will automatically create the INFORMERL.INI file in the default Windows directory if it does not
exist and will insert the [InfView] heading and the options automatically.

A typical INFORMER.INI file will look like:

[Print]

MargLeft=0.00
MargTop=0.00
MargRight=0.00
MargBottom=0.00
PageNumbers=False



LineNumbers=False
FontType=0

[InfView]
ViewType=Ascii
LastDir=C:\WINDOWS
ShowEdit=False
Replace=False
DrivePrompt=True
HexEdit=True
StatusLine=True
Font=MS Serif,-11,400,0,0
PointSize=80
LineLength=512
BackColor=6
TextColor=16
SelColor=16

SelText=16
PrintType=Direct
File1=c:\windows\win.ini
File2=c:\dos\append.exe
File3=c:\windows\myapp.exe
WinLeft=208
WinTop=168
WinRight=784
WinBottom=496
AutoTile=2
Recycle=True
MaxViews=2



Closing InfView

You can close InfView by selecting the "Close™ option from the System Menu or you can double click
your mouse on the System Menu indicator at the top left corner of the InfView Window.

When you execute a file using the "Execute™ menu option, InfView automatically shuts down after the file
is loaded.



The Viewing Window

When InfView is first loaded it will appear as a Window on your screen. This window has several areas
to which you have access:

The Menus

The Status Line

The File Viewer

The Menus

File - This option is used to Open New Files, Save Viewer contents to a file and to Close InfView.
Edit - Save selected text to the clipboard and other files.

Search - This option is used to invoke character or word searches within the Viewer area and then to
repeat a subsequent search.

View - Used to toggle the Viewer contents between Ascii, Raw Ascii, Hex and Text Only views.
Options - These options help configure InfView.

Print - This option allows for printing of the Viewer contents.

Execute - Will attempt to execute the File being Viewed.

Window - Contains options to Tile/Cascade/Arrange and Close multiple windows.

Help - Access the InfView On-Line Help and the InfView Informational Windows.

Minimize and Maximize Buttons - Used to Minimize or Maximize the InfView Window. See the section on

Minimizing and Maximizing the Viewer
The Status Line

The Status line appears directly below the Menu options and provides accurate information to aid you in
using other InfView utility functions.

In Ascii, Raw Ascii and Text Only Modes the Status line contains:
-The currently selected line number.
-The Offset from the beginning of the file of the first character in the currently selected line.
-The file size in characters.

In Hex mode the Status line contains:

-The currently selected line number.

- The Offset from the beginning of the file of the first character in the currently selected line. In
Hex mode each line reflects an offset of 16 bytes from the previous line.

- The file size in characters and Hex bytes.

Note- Currently selected line number indicates the line number in the Viewer, not necessarily the line
number of the file you are viewing.

The File Viewer

The File Viewer portion of the Window contains the contents of the file you are viewing in ASCII or HEX.
The size of the Window will determine how much of the file (lines or columns) is actually shown at any
given time.

Additional Topics:

View a Single Line in Hex

View the entire file in Hex

Minimizing and Maximizing the Viewer
Exposing Edit Characters

Replacing Non-Visible Characters
Changing the Font



View a Single Line in Hex

Rather than view an entire file in Hex, you have the ability to view any line from your Ascii/Raw Ascii/Text
Only modes in Hex, regardless of the actual length of the line. This tool is invaluable for determining
whether there are any hidden or non-visible characters imbedded in your text.

To view a line in Hex, Double click your mouse on the particular line.

A Window will appear: InfView Hex Conversion followed by the number of characters on the line you
selected.

The window will contain lines of Hex values. Each Hex value represents 1 character (byte) on the line
and is seperated by a space from the next one. Each line has 16 bytes translated on it.

When you are done viewing the line in Hex, click on the Ok button to return to the viewing window.



Choosing a Different Viewing Mode

In order to toggle InfView between the different viewing options available, select the View menu option
and then the appropriate Sub-Menu option:

InfView will completely re-read the current file when you toggle between View modes. Reading a file for
Hex view will take considerably longer than reading a file for Ascii/Raw/Text view.

When you Choosing a Different Viewing modes, Infview will position the viewer at the offset of the line
you had selected in the previous mode, thus enabling you to locate the exact position of text between
modes.

Additional Topics:
Ascii View
Raw Ascii View
Hex View

Text Only View



Ascii View

In order to set all open InfView viewing windows to Ascii View, select the View menu option and then the
Ascii View sub-menu option or press Ctrl-A on your keyboard.

The Ascii Viewing option reads a file and then formats the characters of a file by expanding most utilizing
the editing characters within the file.

The mode will display all non-ascii characters except for Hex 0-Nul which is replaced with a space.



Raw Ascii View

In order to set all open InfView viewing windows to Raw Ascii View, select the View menu option and then
the Raw Ascii View sub-menu option or press Ctrl-R on your keyboard.

The Raw Ascii Viewing option reads a file verbatum without using any editing characters within the file.
This is useful for examining binary, executable or system type files.

Each line in the viewer will be filled to the maximum line length.

The mode will display all non-ascii characters except for Hex 0-Nul which is replaced with a space.



Hex View

In order to set all open InfView viewing windows to Hex View, select the View menu option and then the
Hex View sub-menu option or press Ctrl-H on your keyboard.

The Hex Viewing option reads a file and then translates each character into its Hexidecimal equivilant and
then formats lines containing groups of 16 Hex characters with their Ascii translation and the file offset.

Example: 0000:0080 6D 00 A5 34 7D 00 55 10 55 00 71 24 69 00 59 28 | m..4..U.U.q$i.Y(

In the ascii translation of each Hex character on a line, only Ascii characters are displayed, all non visible
characters are translated to "'

Additional Topics:
Hex Translation Table



Text Only View

In order to set all open InfView viewing windows to Text Only View, select the View menu option and then
the Extract Text Only View sub-menu option or press Ctrl-E on your keyboard.

The Text Only Viewing option reads a file and extracts only the visible Ascii characters out of the file.
Editing characters within the file are expanded as well.line

This mode is useful for displaying word processing, spreadsheet and other types of files that contain text,
such as:

Microsoft Write
Microsoft Word
Ami Pro

Word Perfect
Microsoft Excel
Quattro Pro

The mode will NOT display any non-ascii characters, however many word processors and spreadsheet
use regular ascii characters for their formatting so do not be suprised if you do still have what appears to
be garbage throughout the file.



Viewing Images

InfView will let you view any 16 or 256 color Bitmap, PCX or GIF image. In order to view an image, first
load the file using any Ascii/lHex mode. Once loaded, select the View menu then the "Display Image"
sub-menu option or press Ctrl-D on your keyboard.

If the file you are viewing is not a valid image or is of an image format not yet supported, then InfView will
be unable to create an image window.

Loading most images will only take a second or so. Once the image has been loaded InfView will create a
new MDI window with the image displayed. (if you have the maximum windows open then InfView will
close the oldest prior to displaying the image window).

When you have an image window active most of the menu options are disabled except for the Close and
Exit options.

Note: Due to a bug in either Windows or InfView the Maximize feature of an image window has been
disabled since it tended to produce GPFs on a regular basis. We are working on this problem, however
you can still Minimize, Restore and Size any image window.

Note: The GIF image format is a compressed image format developed by CompuServe (c) several years
ago. It does take longer to decompress and load the image than it does for Bitmap or PCX. On
average, each 100k of GIF image takes between 7-10 secondsto decompress and load.

Additional Topics:
InfView's DLLa



Listing Contents of Zip,Lzh Compressed Files

InfView can list the contents of Zip and LZH compressed files. After loading the compressed file into the
viewer, select the List Contents of Compressed Files option from the 'View' menu option.

InfView has build in routines to list the contents of Zip and Lzh compressed files, however in order for you
to load a selected file from a compressed set of files you must have an appropriate decompression
routine available, ie:

- PKZIP for Zip type compression.
- LHARC for Lzh type compression.

Various other vendors provide lookalikes for these compression types. Be sure to register the routines
you select for decompression! See the section on IntelliLib Setup for instructions of how to make InfView
aware of the location of your decompression programs.

Additional Topics:
InfView's DLLs

IntelliLib Setup



Minimizing and Maximizing the Viewer

Minimizing InfView will reduce the viewing Window to an ICON at the bottom of your screen. Double
click your mouse on the ICON (or select it and press <Enter>) to restore it to its original size.

Maximizing InfView will enlarge the current viewing window to use the entire screen. You should
maximize when you are viewing files with more than 80 characters on a line.

Both the Infview application window as well as each individual file view window can be sized using the
Size option on the system menu of InfView or you can use standard Windows drag techniques to change
the size.



Exposing Edit Characters

Edit characters include Carriage Returns, Line Feeds, Tabs, Back space, Form Feed, etc. This option
will allow to see these editing characters in an expanded form rather than in their non-visible form. You
can use this option to inspect text for extra Editing characters.

To invoke this option, select the Option menu option followed by the Expose Editing Characters sub-
menu option. A Checkmark will appear next to this sub-menu option.

To turn this option off, select the Option menu option followed by the Do Not Expose Editing
Characters sub-menu option. A Checkmark will appear next to this sub-menu option.

When this option is on, non-visible editing characters will be replace by:

Carriage Return - [CR]
Line Feed - [LF]

Back Space - [BS]
Tab - [TB]

Form Feed - [FF]
Vertical Tab - [VT]

The file is re-read and reformatted in the Viewing Window each time this option is turned on or off.

This option does not work in Hex View mode.



Changing the Font

InfView can be configured to display files in any available Windows Font, including TrueType. When you
change fonts InfView automatically remembers the change and uses the new font in subsequent viewing
sessions.

To change the Font select the Options menu option and the select the Change Font sub-menu option.

After selecting a font and size from those available to you, select the Ok button to save the change and to
cause InfView to repaint all open file views using the new font.



Preferences

Certain InfView configuration options which are less frequently modified are kept in the Preferences
section of the Options menu option.

Prompt for Drives during Network Search - This option will ask you whether you want to search each
logical drive in a Network File or Word search.

Expand Tabs - When selected, InfView will expand the TAB character into the number of spaces that you
specify under Tab Length.

Tab Length - The number of spaces to convert TAB to.

Temporary Directory - The directory that InfView decompresses Zip/Lzh file into. If you do not specify a
directory then InfView will use Windows.

Additional Topics:

Changing the Line Length
Changing the Colors
Changing the Print Director
Multiple Open File Options



Changing the Line Length

The Line Length denotes the maximum number of characters that can be displayed on a single viewer
line. InfView defaults to 255 characters.

You can modify the Line Length to be any value between 20 and 1024 characters. When you modify the
Line Length InfView will redraw the viewing windows to display the new number of characters on each
line.



Changing the Colors

InfView allows you to modify the colors in which files are displayed in the viewing window. By default the
colors are set to the System colors for Text, Background and highlighted text. System colors are set
using the Windows Control Panel.

There are 4 seperate viewing items that you can modify colors on:
Text - The color of unhighlighted text.
Background - The background color for the viewing window.
Highlighted Text - The color of text that has been 'selected' in the viewing window.
Highlight Background - The background color for 'selected' lines.

Once any changes are made to color selections the viewing window will redisplay in the new colors.

Any or all of the viewing items can be set to System colors, causing them to be in the default system
color as defined in the Windows Control Panel.



Changing the Print Director

This setting under the Preferences menu option lets you specify how your printed output will be directed

to the printer, either:
A. Through the Print Manager (Default)
B. Directly to a Port on your system

Additional Topics:
Printing Directly to a Port



Multiple Open File options
There are 3 options for controlling how you view multiple documents in InfView:

1. Maximum Viewing Windows - Lets you choose the maximum number of files that you can view in
InfView, from 1 - 25.

2. Recycle Oldest Viewing Window - This option will recycle the oldest (First Opened) viewing windows
when you attempt to view another file beyond the maximum number of viewing windows. If this option is
off, attempting to open another file beyond the maximum number of files will force a warning message.

3. Automatic Tiling - You can choose to have InfView automatically tile your open files either vertically or
horizontally within the InfView window. If 'Off', then InfView will Cascade the files within the InfView
viewing window.




Replacing Non-Visible Characters

When you are inspecting a text file looking for non-visible characters or when you are inspecting a binary
file looking for visible characters, it is difficult to sift through all the non-visible and garbage characters.
This option forces InfView to re-read the file and to replace all non-visible characters in the Viewing
Window with a '~' character.

To invoke this option select the Option menu option followed by the Replace Non-Visible Characters
sub-menu option. A Checkmark will appear next to this sub-menu option and InfView will proceed to re-
read and reformat the file in the Viewing Window.

To turn this option off, follow the same steps. The Checkmark will disappear from the menu.

This option does not work in Hex View mode.



Showing/Hiding the Status Line

The Status line is a valuable tool for indicating position, offset and search list information. By default it is
visible in both Ascii and Hex modes, however you can hide it to provide more viewing space.

To toggle whether the Status line is visible or not, select the Options menu item followed by the Show
Status Line menu option. If the Status line is visible there will be a Checkmark next to the menu item.
The Viewer will immediately refresh itself when this option is changed.



Opening a Different File

When you want to view a different file, select the File menu option, then the Open File sub menu option.
You will be shown the standard Windows "Open File" Dialog. Select a path and file from this dialog and
then select the "Ok™ button to cause that file to be loaded.

If you select the "Cancel" button from the "Open File" dialog, you will return to the File Viewer Windows
with the old file still loaded.

When you open a different file without first closing the current file you are viewing, InfView will open
subsequent windows with new files up to the Maximum number of Views that you can set under
'Preferences’.

Note: The "Open File" dialog loads with the directory path of the file that was most recently loaded.
This allows you to progressively view files within a directory without having to locate the Directory each
time.

Additional Topics:
Opening Previously Viewed Files



Opening Previously Viewed Files

InfView remembers the last 3 files that were viewed. The paths and names of these 3 files are stored in
the INFORMER.INI file and are dynamically listed under the Files menu option.

Each time that a file is opened, both the Informer.Ini and the menu list are updated so that you can easily
return to a previously viewed file without searching for it.

To open a previously viewed file select the Files menu option and then either double click your mouse on
any of the previously viewed file names or press 1,2 or 3 on your keyboard to load the matching file.



Reloading the Current File

At times you may want to Reload the file that you are viewing from the Disk file that was originally read,
ie: If the file changes.

To reload the current file select the View menu option and then select the View Type that you are
currently using (Indicated by a Checkmark next to the menu option). InfView will reload the file in the
current View Type.



Saving the Viewer to a File

This option allows to you to save the current contents (or a portion thereof) of the File Viewer into a File of
a different name. You can save Hex views (or a portion thereof) as well.

To Save the Viewer contents, select the File menu option, then the Save Viewer Contents sub menu
option.

The "Save" Dialog that will appear has the following options:

File Name - Enter the path and name of the file to which the Viewer contents will be saved. If the file
exists you will be asked to confirm the overwrite of the file prior to the Save operation being executed.

Heading - Enter an optional heading which will be written as the first line of the file. This is useful in the
case of saving Hex as a comment. (up to 60 characters).

Save From Line - Line 1 is automatically filled into this field. If you want the starting line number to be
different, enter it here.

To Line - The line number of the last line in the File Viewer is filled in here. If you want a different ending
line number, enter it here.

Browse Button - Select this button to invoke a "File Save" selection dialog which will allow you to
traverse the hard disk (or network) for a specific path and file name.

Note: This option does not save files in their original format; it saves them in their viewed format.



Searching in the Viewer

The searching capabilities of InfView allow you to search for Characters, Words, Series of Words, Hex
Values or Offsets. InfView allows for an initial Search request and then allows for additional repetitions of
the same search.

What you can search for

In Ascii mode you can search for:

- Characters
- Words
- Groups of Words

In Hex mode you can search for:

- Characters

- Words

- Groups of Words
- Hex sequences
- Offsets (in hex)

Starting a Search

To start a search select the Search menu option, then the Search sub menu option.

A Search window will appear asking you to enter the text you wish to search for (up to 50 characters in
length). You may also specify that the search will be case sensitive by selecting the Case Sensitive
button.

When you have made your selections, click on the Ok button to start the search or click on the Close
button to cancel the search.

Additional Topics:

Repeating a Search
Searching All Viewed Files



Repeating a Search

Once an initial search has been made you can repeat the search to look for the Next occurance in the
viewing window by clicking on the Search menu followed by clicking on the Repeat sub-menu, or you can
press F3 on your keyboard.

Subsequent repetitions of the search will continue until no more occurances are found in the viewing
window upon which time you will be presented with the message No more occurances found.

Note: This search facility will only look for a single occurance of the search characters on any given line.



Searching All Viewed Files

You can use the same procedure to search for characters or words within all files which you are viewing
in InfView.

Use the Search All and Repeat Search All menu options under the Search menu.



Comparing Files Being Viewed for Differences

InfView provides an simple and effective way to compare files that are being viewed for differences. The
comparison works in Ascii,Raw and Hex modes with at least 2 files being viewed. You can compare up
to 25 files at once!

Using the Compare All Views option under the 'Search' menu or pressing Ctrl-C on your keyboard starts
a comparison of all files being viewed from the first line in each view.

The File Comparison bases its comparison on an Original File View. The original file view is always the
active file that you are viewing (the one that has keyboard input). To change original files, click your
mouse on the view of the file you want to be the original.

When the File Comparison finds a difference between files it will present a message indicating on which
line of the original the difference was found. When you acknowledge the message, InfView will position
the files being viewed as follows:

The original file - Will select the line which was different in at least 1 of the other views. The
Status line on the original file view will change to: Compare: Original File Line: xxx.

Files that were different - All files that had a different line x than the original will have the line that
was different selected. The Status line will change to: Compare: Failed on this file, line xx

Files that were not different - All files that did not have a different line x will remain unchanged.

A message will appear if there are no more differences between files.

Additional Topics:

Continuing the Comparison
Loading from the Command Line



Continuing the Comparison

You can continue a comparison at any time, even if you have added or removed files being viewed. Use
the Continue Compare option under the 'Search' menu or press Alt-C on your keyboard.

The continue comparison continues the comparison in each view from the line that is selected in that
view. However if you request a Continue Compare immediately after Compare Files has found a
difference between files, InfView will continue with the next line after the difference was found.

Example: If the original comparison found a difference between 2 files, it would highlight the lines that
were different. In order for you to continue the comparison, you could either use Continue Compare to
continue the comparison on the next line in each view, or you could select the lines in each view that
match the Original file to continue from that point.

A message will appear if there are no more differences between files.



Searching the Disk for Files

This search facility is not unlike GREP or FILEFIND in the Dos environment. You can find all occurances
of a particular File or File abstract across multiple directories, entire disks or even multiple disk network
environments.

To invoke the File Search select the Search menu option, then the Search Disk for Files sub menu
option. You can also press the F4 key on your keyboard to invoke the search.

The Disk Search entry screen will appear. The options on this screen are:

File Name to Search For: Enter the name and extension of the file(s) you wish to search for. You can
use wildcards and partial file names, ie: ABC*.TXT or WIN.* or FED*.*

Search Path - The default drive will appear in this field, however you can modify it to be any drive
(including network) or any path within a drive. The search will start with the Drive or Path you enter and
will include all subdirectories.

Search All Drives - If you select this option the search will proceed to search every drive on your network,
starting with the root directory of each drive.

Prompt After Match - If you select this option after each matching occurance is found a Messagebox
appears indicating in which directory it was found and also gives you the option of terminating the search
at that point.

Select only files with size > - If you select this option you are required to enter a maximum file size (in
bytes) in the entry field next to this selection. InfView will then only select files that are at least the size
you indicate.

Select only files with size < - If you select this option you are required to enter a minimum file size (in
bytes) in the entry field next to this selection. InfView will then only select files that are less than or equal
to the size you indicate.

Select only files dated - This selection allows you to indicate an earliest date for which a file can be
selected. The default in this field is the system date, however it can be modified. During the file
selection routine only files that are created or modified from the date you indicated or later will be
selected.

Search for files within Zip/Lzh - If you select this option the search will determine whether the search file
exists within the Zip/Lzh compressed data set.

After you have completed making your options, select the Start Search button to start the search (press
Alt-S) or select the Close Search button to return to the InfView viewing window.

All files that are found that match your search criteria will be listed in the area below the search options as
follows:

File Name - Full name and path of the file.

Zip Flag - If the file listed is a Zip/Lzh compressed data set and the file you were searching for is
compressed, then either <zip> or <lzh> will appear next to the file name.

Date - The date and time of the file.

File Size - The size in bytes of the file.

You can now load any of the files listed in the Search List into the viewer by Double Clicking your mouse
on a file, or by selecting a file and then pressing the Load File into Viewer button.



Additionally, if you want to see a list of all the files within a Zip/Lzh compressed data set, select the
compressed data set from the Search List and press the List Files button.

Additional Topics:
The Search list



Searching the Disk for Words/Characters

The Word Search facility of InfView will search all files in a particular directory, series of directories, disk
or multiple disks for a given character, word or series of words. In most cases this search will be able to
locate series of characters within binary (executable, etc..) files.

To invoke the Word Search select the Search menu option, then the Search Disk for Words sub menu
option. You can also press the F5 key on your keyboard to invoke the search.

The Disk Search entry screen will appear. The options on this screen are:

Word to Search For: Enter a character, series of characters, word or multiple words you wish to search
for. Your entry can be up to 25 characters in length.

Search Path: The default drive will appear in this field, however you can modify it to be any drive
(including network) or any path within a drive. The search will start with the Drive or Path you enter and
will include all subdirectories.

Search All Drives If you select this option the search will proceed to search every drive on your network,
starting with the root directory of each drive.

Case Sensitive If you select this option then the search will only match your search criteria when all the
case of each character matches exactly.

Prompt After Matchlf you select this option after each matching occurance is found a Messagebox
appears indicating in which directory it was found and also gives you the option of terminating the search
at that point.

Select only files with size > - If you select this option you are required to enter a maximum file size (in
bytes) in the entry field next to this selection. InfView will then only select files that are at least the size
you indicate.

Select only files with size < - If you select this option you are required to enter a minimum file size (in
bytes) in the entry field next to this selection. InfView will then only select files that are less than or equal
to the size you indicate.

Select only files dated - This selection allows you to indicate an earliest date for which a file can be
selected. The default in this field is the system date, however it can be modified. During the file
selection routine only files that are created or modified from the date you indicated or later will be
selected.

After you have completed making your options, select the Start Search button to start the search (press
Alt-S) or select the Close Search button to return to the InfView viewing window.

All files that are found that match your search criteria will be listed in the area below the search options as
follows:

File Name - Full name and path of the file.
Date - The date and time of the file.
File Size - The size in bytes of the file.

You can now load any of the files listed in the Search List into the viewer by Double Clicking your mouse
on a file, or by selecting a file and then pressing the Load File into Viewer button.

Additional Topics:
The Search list






Searching the Current Directory

The Directory search allows you to build a Search List containing all of the files in a given directory. You
can modify this search to search for particular file abstracts in a directory as well.

To invoke the Directory Search select the Search menu option, then the Search Directory sub menu
option. You can also press the F6 key on your keyboard to invoke the search.

The Disk Search entry screen will appear. The options on this screen are:

Files To List: By default this field will show ".*" indicating all files in the particular directory will be listed,
however you can enter the name and/or extension of file(s) you wish to list in the directory, ie: ABC*.TXT
or WIN.* or FED*.*

Search Path: The current directory will appear in this field, however you can modify it to be any directory
on any drive available to you. This search will not examine subdirectories of the current directory.

Select only files with size > - If you select this option you are required to enter a maximum file size (in
bytes) in the entry field next to this selection. InfView will then only select files that are at least the size
you indicate.

Select only files with size < - If you select this option you are required to enter a minimum file size (in
bytes) in the entry field next to this selection. InfView will then only select files that are less than or equal
to the size you indicate.

Select only files dated - This selection allows you to indicate an earliest date for which a file can be
selected. The default in this field is the system date, however it can be modified. During the file
selection routine only files that are created or modified from the date you indicated or later will be
selected.

After you have completed making your options, select the Start Search button to start the search (press
Alt-S) or select the Close Search button to return to the InfView viewing window.

All files that are found that match your search criteria will be listed in the area below the search options as
follows:

File Name - Full name and path of the file.
Date - The date and time of the file.
File Size - The size in bytes of the file.

You can now load any of the files listed in the Search List into the viewer by Double Clicking your mouse
on a file, or by selecting a file and then pressing the Load File into Viewer button.

Additional Topics:
The Search list



The Search List

The Search List is a semi-permanent listing of files that matched the criteria you presented in the last Disk
Search. The Search List can be revisited multiple times and can be used to load files directly into the
viewer.

The Disk File Search, Word/Char Search and Current Directory search all share this list, so that the
contents of the Search List will be replaced on each subsequent search by any of these 3 search types.

When you request a search (see the Search explanations) all the files that were found on your disk that
matched the search are loaded into the search list. If you select a file from the search list it will be
loaded into the viewer.

The next time you request a search, the Search List will be intact until you actually start the search.
Additional Topics:

Loading the Next File from the Search list
Loading the Previous File from the Search list




Loading the Next File from the Search List
You can traverse the Search list in either direction to quickly view each file.

To Load the next file from the Search List select the Search menu option then select the Next Item from
Search sub-menu item or press Shift-PgDown on your keyboard.

After loading the last file in the Search List you will receive the message "You have reached the last
item in the Search List".



Loading the Previous File from the Search List
You can traverse the Search list in either direction to quickly view each file.

To Load the previous file from the Search List select the Search menu option then select the Previous
Item from Search sub-menu item or press Shift-PgUp on your keyboard.

If you are viewing the First file in the Search List and attempt to view the Previous file, you will receive the
message "You have reached the first item in the Search List".



Going to a Line Number

You can move to a specific line of the viewing text by selecting the Search menu option followed by the
Goto Line sub-menu option.

A window will appear indicating the range of line numbers in the Viewer. In the Entry field where your
cursor is initially positioned, type the line number to which you want the viewer to position itself.

If you enter a line number outside the allowable range, InfView will not change line positions.



Executing a File

Many times you will find yourself viewing a file and then wanting to execute it. InfView provides a
function that will execute many of the files that you will be viewing.

If the file you are viewing is an "EXE" "COM" "BAT" or "DLL" file, the "Execute" menu option will cause
the file to be loaded and run. This includes Dos executables and Dos Batch files.

For any other type of file, InfView will search the "Extensions" table in your WIN.INI file looking for an
application that matches the extension of the file you are viewing. If an entry is found InfView will load
the application and will pass the name of the file you are viewing to the application to load.

Caution with Dos Batch Files: Dos Batch files will execute, however unless they require user input,
control will immmediately be returned to Windows, in fact you will probably only see your screen flash as an
indication that the batch file has run. Any "Pause" or user input statements or program execution
statements in the Batch file will continue and complete before returning control to Windows.



Identifying a File

InfView has the ability to identify a vast array of files based on either internal characteristics of the file or
on the File Extension. This ability is invaluable when you are unsure of the type of file you are viewing or
what application created or used the file.

To invoke the identification algorythm, select the File menu option and then select the Show Information
sub-menu option.

Immediately a window will appear describing:

- The name of the file.

- The type of file. (identified either internally or through it's extension)

- Any Windows Associations that exist for this particular extension of file. Associations are found in the
WIN.INI file and are established using File Manager.

- The Size of the file in bytes and Kbytes.

- The Date of the last modification of the file.

Additional Topics:
Modifying the Identification List



Modifying the Identification List

In order to allow for flexibility and future expansion, InfView maintains a table of File Extensions and File
descriptions. You are able to modify this list at any time and once the modification is made, InfView will
recognize the changes and utilize them in any attempts at file identification.

The list is maintained in the: INFORMER.INI file located in your Windows directory.

The INFORMER.INI file is used by all programs in the Informer series including this one, however the
section you will be modifying within INFORMER.INI is used exclusively by InfView.

Using an Editor (or the INFORMER Configuration Editor) open the INFORMER.INI file. Search for
[Extensions] within the file. InfView installs with approximately 75 Extension/Descriptions which should
all be listed after the [Extensions] header. The format of each entry in this list is: Extenion=Description,
ie: bat=DOS Batch File. You are not restricted in upper and lower case characters as a lookup for an
extension is not case sensitive.

If you have 2 entries with the same extension but with different descriptions, InfView will only return the
first entry.

Once you have modified the list, Save it! InfView will immediately have access to the modifications.

Note: If you do not have an INFORMER.INI file or there is no [Extensions] section in your
INFORMERL.INI file you should reinstall InfView by running the SETUP.EXE file that is included on the
diskette or in the INFVIEW.ZIP file you received. If you do not have a SETUP.EXE file then your version
of InfView may not be complete or current. Contact us for a complete and current copy.



Memory Considerations for Large Files

InfView uses the Heap to allocate space for each file that is loaded. Heap consists of most of the
available RAM as well as additional space provided by setting up a swap file under Windows..

When InfView is reading a large file, the Windows Heap Manager must continually provide it with memory
in order to put the entire file in memory and in the list box on your screen.

Depending on your system and on the amount of available memory and the size of your Windows swap
file, you may find that InfView slows down reading large files (2 megabytes or so...) in Ascii View mode.
However, in Hex View mode, each 16 bytes of disk file requires 80bytes of "viewing space" due to the fact
that the Offset, Hex code and Ascii code are all displayed on the screen.

An indication of a slowdown due to Windows is the "Reading File : xx% complete" indicator that is at
the top of the InfView window while the file is being read. The percent complete will take several
seconds to increment or may stop altogether while your disk shows activity.

You will probably not encounter this problem on systems with more than 4megs of memory and this
problem will not happen on Windows NT or OS/2 systems.

Why does this happen? Windows is trying to swap the contents of its memory to disk in order to
provide InfView with the memory it requires.

What can | do? If you have to view an extremely large file, before running InfView on that file, shut down
as many Windows applications as you can and unload any modules and Windows resident libraries.

How do | stop InfView? If InfView gets bogged down during a read, there is really only one way to
abort the process, do a CTRL-ALT-DEL and select the option to "Terminate a task that is not responding" -
usually by pressing ENTER. This will terminate InfView, free the Memory that InfView was requesting
and then return you to Windows.

How much Memory do | have? There is really no way for you to determine exactly when Windows will
stop using Ram Heap and start swapping to disk. We have provided an indication of contiguous memory
available for Heap in the About dialog under the Help menu option. In testing we have found that this
number is generally a good indication of the maximum file size that will load without slowing down the
system due to swapping.

The advantage of using InfView is that the entire file is loaded into memory which eliminates possibilities
of sharing violations and allow for Snapshots of files to be taken and held within the Viewer while the file
itself may be updated. However, if your need for a viewer is to examine incredibly large files ALL THE
TIME, then we suggest that you use other viewers on the market that do a buffered read of a portion of
the file at a time.



Printing a File

InfView can print files both in the Ascii and the Hex views. You can print an entire file or just a portion
and you can select limited formatting for your print job.

To print a file, select the Print menu option or press Alt P on your keyboard.

Additional Topics:
Printing Selected Text
Print Options
Selecting a Printer
Selecting a Communications Port



Printing Selected Text

When you select several lines of text, you can print it directly from InfView without Cutting it to another
file.

After highlighting the selected text, select the Print menu option. The Print Dialog will appear with the
title "Print Selected Text" and the 'Print Selected Text, Lines: xx - xx' Button will be checked.

The range of lines that you selected will appear in the fields next to 'Print Selected Text, Lines:'. You can
adjust the range, modify the print options or Start the print job.



Print Options

Before printing a file or a portion of the Viewing Window, you must select the various print options from
the Print Request window.

Printer - see the section on Selecting a Printer
Printer Port - see the section on Selecting a Communications Port

Margins - The Left,Right, Top and Bottom margins can be modified so that your print page size can be
adjusted. Valid values are from 0-page size in inches and parts of inches.

Copies - Select the number of copies to print.

Print Font - You can choose between printing using the Font used in the viewer or the Default printer
Font.

Print Lines - The values that are initially shown here are '1' and 'Number of Lines' in the text. You may
adjust these values to print only a portion of the file or Viewing Window.

Print Selected Text - If you only want a specific range of line numbers to print, select this button and enter
the range of line numbers.

Print Line Numbers - If you select this field your output will have line numbers printed at the start of each
line.

Print Page Numbers - If you select this field your output will have page numbers at the top of each page.




Selecting a Printer

The Print Request window will show you the currently selected printer in the Printer field. [If you want to
change to another available printer, click on the Select Printer button.

The Select Printer window will appear with a list of available printers as well as your current printer. To
select any of the available printers, Click your mouse on the selection, it will then appear in the Current
Printer field.

Click on Ok button to save your change of printer, otherwise click on Cancel to exit without changing your
printer.

It is recommended that you Set up a printer that has been made active. This can be done using the
Setup button on either the Print Request window or the Select Printer window. The setup for each
printer will be different, consult the printer manual or the Windows manual for more information.



Selecting a Communications Port

You can change the communications port to which you will be printing. This facility can let you print to a
printer hooked to any valid port. In addition, this option provides a means for you to print to a file.

In the Print Request window there will be a list of available ports and a field showing the port to which
you are currently assigned, for example:

-LPT1:
-LPT2:
-LPT3:

- COM1:

- COM2:
-EPT:

- FILE:
-LPT1.0S82

To change ports, select the port to which you want to direct your output then double click your mouse on
that selection.

When selected, the new port will appear in the Printer Port field.

Note: InfView or Windows will not ensure that a printer is connected to the port until such time as a file is
printed.



Printing Directly to a Port

This option allows you to print directly to a port, effectively bypassing the Print Manager. This can be used
to print files that have embedded printer control characters.

The Direct Print Request window has the following options:
Printer Port.
Number of Copies.
Print selected Text.

After choosing your options, select the Print button to start the print job or select the Cancel button to
return to the Viewing Window.



The Hex Editor

InfView has an optional Hex Editor that will facilitate the modification of any type of file being viewed in
Hex mode.

The Hex Editor can only be used in the Hex viewing mode and any modifications made in Hex mode will
not appear in the Ascii mode unless the file has been saved.

To invoke the Hex Editor, Double Click on any Hex line in the viewer.
The Hex Edit window will appear, displaying:

- The 16 Hex byte pairs
- The 16 Ascii bytes

You may now modify either the Hex or the Ascii values. Once a change to either line is made, the other
values will automatically be translated and modified to their new values, however this will only occur once
there are 16 bytes to translate.

When you have completed your changes to the line, you may choose:

Ok - To update the viewer with the modified line.
Cancel - To return to the viewer without modifying the contents.
Restore - To restore the Hex Edit line to its original contents.

The Viewer will update the modified line only if the Ok button was selected.

If you attempt to:

- Change viewing modes.

- Load another file.

- Exit InfView.
after modifying the file, you will be notified that "The File has been modified, do you want to Save the
changes". If you reply Yes to this inquiry, the modifications will be saved to the file. (See "Saving a
Modified File")

Additional Topics:
Saving a Modified File



Saving a Modified File

Once a file has been modified, the Save File sub-menu option under the File menu will be enabled.

To save the modified file select this sub-menu option. The Save File screen will appear with the name of
the file being viewed as the Save file name. Select Ok to accept the name and continue with the save

process, or you may enter a different name or use the Directory tree structure to select a different name.

After selecting the file name, InfView will notify you if the file already exists. You can accept the overwrite
request which will overwrite the existing file on disk with the contents of the Hex Viewer.



Keyboard Hot Keys
The following keyboard Hot Keys can be used to invoke various InfView functions immediately:

General Hot Keys

Ctrl-A - Ascii View mode.

Ctrl-H - Hex View mode.

Ctrl-R - Raw Ascii View mode.

Ctrl-D - Display Image.

F1 - Help Index.

F2 - Start a character search within the Viewed file.
F3 - Repeat the last character search within the Viewed file.
F6 - Build a list of all files in the current directory.
F8 - Cut selected text to the Windows Clipboard.
F9 - Cut selected text to a file.

Ctrl-l1 - Show Information on active file view.

Disk search Hot Keys

F4 - Start a Disk File Search.

F5 - Start a Disk Word Search.

Shift-PgDown - Load next file from Search list.
Shift-PgUp - Load previous file from Search list.

Multiple file Hot Keys

Shift-DnArrow - Scroll all open files down 1 line.
Shift-UpArrow - Scroll all open files up 1 line.
Shift-F2 - Character search in all open files.
Shift-F3 - Repeat character search in all open files.
Ctrl-C - Compare all open files.

Alt-C - Continue compare of all open files.

Cursor Movement

Up,Down,Left,Right Arrows - Move active window in that direction.
PgUp,PgDown - Scroll active window up or down 1 page.
Tab,BackSpace - Scroll active window right or left.

Home,End - Position active window at beginning or end of file.
Ctrl-G - Goto a specific line.

Ctrl-S - Select all lines.




InfView's DLLs

Using IntelliLib (tm) technology, InfView can optionally load DLLs to perform tasks that are not part of the
main function of the main program.

INFVUIMG.DLL - This DLL is used to load Bitmap and PCX image files.
INFVUGIF.DLL - This DLL is used to decompress and load GIF image files.

INFVUZIP.DLL - This DLL is used to list the contents of Zip,Lzh compressed files and then to decompress
and load specific files from within the compressed file set.



Hex Translation Table

The following table shows all Visible or Control Characters. Each line shows Decimal value - Hex value -
Character value:

00-00-NUL 32-20-SPC 64-40-@ 96 -60-'

01-01-SOH 33-21-! 65-41-A 97 -61-a
02-02-STX 34-22-" 66-42-B 98-62-b
03-03-ETX 35-23-# 67-43-C 99-63-c
04-04-EOT 36-24-% 68-44-D 100-64 -d
05-05-ENQ 37-25-% 69-45-E 101-65-e
06-06-ACK 38-26-'& 70-46-F 102 -66 - f

07-07-BEL 39-27-' 71-47-G 103-67-¢g
08 - 08 - BS 40 - 28 - ( 72-48-H 104 -68 - h
09-09-TAB 41-29-) 73-49-1 105-69-i

10-0A-LF 42 -2A -~ 74 -4A-J 106 - 6A - j
1-0B-VT 43-2B-'+ 75-4B-K 107 - 6B -k

12-0C-FF 44-2C-, 76-4C-L 108 -6C - |
13-0D-CR 45-2D-- 77-4D -M 109-6D-m
14-0E-SO 46-2E-. 78 -4E - N 110 -6E - n

15 - OF - Sl 47 - 2F -/ 79-4F -0 111-6F -0
16-10-DLE 48-30-0 80-50-P 112-70-p
17-11-DC1 49-31-1 81-51-Q 113-71-q
18-12-DC2 50-32-2 82-52-R 114 -72-r
19-13-DC3 51-33-3 83-53-S 115-73-s
20-14-DC4 52-34-4 84-54-T 116 -74 -t
21-15-NAK 563-35-5 85-55-U 17-75-u
22-16-SYN 54-36-6 86-56-V 18-76-v
23-17-ETB 55-37-7 87-57-W 19-77-w
24-18-CAN 56-38-8 88 -58-X 120-78 - x
25-19-EM  57-39-9 89-59-Y 121-79 -y

26-1A-SUB 58-3A-: 90-5A-Z 122-7A-z
27-1B-ESC 59-3B-; 91-56B-[ 123 -7B - (
28-1C-FS 60-3C-< 92 -5C - 124 -7C - |
29-1D-GS 61-3D-= 93-5D -] 125-7D -)
30-1E-RS 62-3E-> 94 -5E -~ 126 - 7E - ~
31-1F-US 63-3F-7 95-56F - _ 127 - 7F - _

Character codes 128-255 (80-FF) are non-visible characters.



Revision History

Version 1.45 - 03/05/94

1. InfView now uses IntelliLib (tm) to manually loadit's DLLs so that if the graphics DLLs are missing, the
program can still run for normal viewing functions.

2. New DLL to handle viewing the contents of ZIP and LZH libraries. Also will use Pkzip or LHA to
uncompress a selected file from the Zip or Lzh into the viewer.

3. Corrected bug in Next & Prev search list that were receiving the file date instead of the file name.

4. On Startup the Open File Dialog will now show the name of the last file edited - using CANCEL will load
it.

5. If you open a Zip or Lzh file you will immediately get a listing of all the files compressed within, you can
then load either the compressed file or select a file to decompress and load.

6. The Disk\Network File Search now has an option to allow it to search for your search criteria within Zip
and Lzh compressed data sets. If the file is found you optionally can decompress the specific file from
the Zip/Lzh.

Version 1.44 - 02/10/94

1. Removed Debug line from Direct Print (sorry...)

2. Added GIF Viewing (INFVUGIF.DLL). The 'Display Image' menu option under 'View' menu will invoke
this DLL if the image file is a GIF type.

Version 1.43 - 02/05/94
1. Added BitMap and PCX Viewing (INFVUIMG.DLL). New Menu option 'Display Image' under 'View'
menu allows you to view any 16/256 color Bitmap or PCX file.

Version 1.42 - 01/27/94

1. Hex Editor bug corrected, now it won't give an error everytime you say OK.

2. Hex Editor will now not update the file when 'Cancel’ is pressed,

3. Three menu options: 'Save File', 'Save Viewer Contents to File' and 'Close Window' were added to the
MDI message dispatcher because of complaints that they did not always work under each local window.
4. Character Search expanded to have Hex Search screen allowing seperate Hex and Ascii search
strings (or both).

5. Bug fixed in Character search that caused all searched lines to appear in the viewer in upper case.

6. Viewer character search expanded in Ascii and Hex to search between lines (ie: part of the word on 1
line, part on the next).

7. Disk/Network character search expanded to search between blocks (ie: part of the word on 1 line, part
on the next).

8. 'Print' Menu option was moved to be a submenu option under 'File'.

9. Corrected error while printing selected text under both 'Direct’ and 'Print Manager'.

Version 1.41 - 01/10/94

1. Added Drag 'n Drop feature. Lets an application drag MULTIPLE files onto Infview for display.

2. Corrected Command Line to accept up to 9 file names, ie: "INFVIEW \AUTOEXEC.BAT
\CONFIG.SYS \WINDOWS\WIN.INI".

3. Fixed another repaint problem: when you reselected the last line of several selected lines (single
mouse click) the screen would not repaint.

4. Added code to release several memory objects (Fonts,Pens) that were chewing up the heap.

5. Command Line can invoke a compare via the "\c" option, ie: "INFVIEW WIN.INI WIN.BAK \c". Note:
the "\c" can be anywhere within the command line options.

Version 1.40 - 01/04/94
1. Changed to MDI application, you can now have multiple files viewed at the same time (up to 25). The
following new menu functions have been added to support multiple document viewing:

- Scroll All Down 1 Line.

- Scroll All Up 1 Line.

- Search All.



- Repeat Search All.

- Compare Files.

- Continue Compare.
In addition, options under Preferences have been added to support:

- Maximum File Views.

- Recycle Old Windows.

- Automatic Tiling.
2. Corrected bug that did not release Heap when you opened a new viewing window, caused slow reads.
3. Character search corrected to work on lines with more than 256 characters.
4. The Home and End keys now set the viewer to Column position 1.
5. Executing an open file does not close the Viewing Windows.
6. Changing colors will not cause the open file(s) to be re-read.
7. Font selection has been updated to store ALL the font attributes in a single parameter line Font= in the
INFORMERC.INI file. This solves the problem of Infview loading with the incorrect font.
8. The Prompt for Drives option was taken out of the Options menu and placed into the Preferences
Dialog.
9. The File/Word/Directory Disk Search routine now has selection options to allow you to specify
Maximum file size or Minimum file size or Minimum Creation/Modification Date.
10. Addition of the Extract Text Only mode. Requested by users wanting to get only the text out of
WRITE/WORD/WP files. This mode extracts the text Hex(32-127) characters out of file.
11. Added Contiguous Memory Available display to the About screen. Helps determine maximum file size
to view.
12. Added 'Expand Tabs' and 'Tab Length' fields to Preferences dialog under Options. When selected,
InfView will expand Tabs (Hex 9) to the number of spaces that you specified.

Version 1.37 - 12/20/93

1. Ascii View of Binary files corrected to handle #0 (null) characters.

2. New View option -> Raw Ascii. Shows files exactly the way they look.

3. Hex Conversion in Ascii/Raw Ascii modes now builds a list box with formatted Hex lines showing 16
Hex bytes per line with Ascii translation of each line.

4. Added Preferences Menu option under 'Options' menu.

5. Added ability to specify line length under 'Preferences’. Line length can be between 20 - 1024 bytes.
Screen refreshes when this value changes.

6. Added option under 'Preferences' to select either printing through the Print manager or Directly to a
port.

7. Files that have a last line with no CR/LF will now display.

8. Added Color selection for "Text','Background’,'Selected Text','Selected Background' under Preferences.
Currently colors are listed in drop down box, plan to change it to color buttons or a color wheel. Default
is to 'System' colors.

9. When you Minimize Infview to an Icon and then Exit InfView, the next time InfView is invoked it will be
restored to the last size and position prior to minimizing.

10. Corrected Hex View so that 1st Hex pair is not flush against the Offset position in certain fonts.

11. Correction to The Hex Editor so it will not give a Run time error 201 if you attempted to put Hex values
outside O-F.

Version 1.36 - 12/04/93
1. File/Word search corrected to read Network drives in order.
2. Duplicate lines due to Buffer overflow corrected.

Version 1.35 - 12/01/93

1. Text can now be selected in Forward and Reverse direction.

2. Direct Printing option added. This bypasses the Windows Print Manager and spews data out the Open
Port (Lpt1,2...). Form Feed is done between multiple copies.

3. If you get a File load error you will no longer get a Run Time Error or GPF.

4. Options are loaded from INFORMERL.INI in current directory if it exists, otherwise it looks for
INFORMERL.INI in the Windows default directory.



5. When InfView is started and the OPEN FILE DIALOG is displayed, pressing CANCEL will automatically
load the last file that was viewed rather than leaving a blank viewer.

6. InfView will now display single line files in Ascii mode. (no Cr/Lf).

7. The Status line now displays non-highlighted in the System Font, regardless of the Viewer Font.

8. When you change viewing modes (Ascii/Hex) the viewer positions itself at the offset of the selected line
in the previous mode.

9. Hex viewing mode now shows the byte offset in the status line.

10. The Status Line can now be hidden/displayed by using a menu option under 'Options'

11. The Print Request now allows you to choose between using the WYSWYG Font used in the viewer or
the Default Printer Font.

12. The Font Weight/ltalic/lUnderline settings are saved in the INFORMER.INI and are set when InfView is
loaded.

13. The scroll bar is refreshed when moving between applications on your screen.

Version 1.31 - 11/10/93

1. Correct bug with screen refresh, would not restore screen after switching applications.
2. Correct bug with Hex Print columnization.

3. Correct bug with Hex File Save columnization.

Version 1.30 - 10/21/93

1. Correct menu offset problem on Last 3 files.

2. New Drive Search function to find Files (like FILE FIND).

3. New Drive Search function to find Words within files (like GREP).

4. New Directory Listing function to list all files in the current directory.

5. Added NEXT and PREVIOUS search list option to load files from the search list created from the above
3 functions.

6. Added Hot Keys for all of the above as well as F1 for Help.

7. Changed 'SHOW EDIT CHARS' to a single menu option with checkmark.

8. New Hex Editor (DEBUG) function to change Hex View of files and to save updated files back to disk.
9. TrueType flicker reduction by only painting changed lines of the viewer.

10. In Hex View Mode, Columns now line up for True Type fonts.

Version 1.20 - 10/07/93

1. Added ability to do Cut&Paste type operation to Copy selected text to the Clipboard.

2. Removed 'ldentify' menu option and replaced it with a 'Show Information' sub-menu under 'Files'.
Identifies files and shows File size & date.

3. Added 'Options' menu option and moved several 'View' options to it.

4. Added function to change the Font! Under the 'Options' menu you can select the Font for the Viewer.
Font name and size are saved in INI and are used in subsequent sessions.

5. New 'Print Selected Text' dialog which will allow you to print text which you have selected.

6. Corrected bug which failed display text on memory boundaries.

7. Last Directory you were in is stored in the INFORMER.INI and is used during your next session for the
'File Open' dialog.

8. New 'Goto Line' option under 'Search menu'.

9. Search positions the line where text was found at the top of the viewer window.

Version 1.10 - 09/30/93

1. Correction to Hex routine to show final Hex characters of a file.

2. Print Request screen allows specific line range to be printed.

3. The following user options are saved in INFORMER.INI under INFVIEW heading: Hex or Ascii View,
Show Editing Characters and Translate Non-Visible characters.

4. List of file extensions and descriptions were moved from HARDCODED to a dynamic list within the
INFORMER.INI'  under EXTENSIONS heading.

5. The last 3 files viewed are saved and displayed under the FILES menu option and can be loaded
directly from the menu.

6. You can save a range of lines to another file in Ascii or Hex.



7. The REPEAT search menu option can be invoked using the F3 key.

8. Menu option was added to expose editing characters in the viewed file, this includes CR,LF, TAB, etc...
9. Menu option was added to translate all non-visible characters to the '~ ' character for the viewed file.
10. The size and position of the InfView window is remembered between viewing sessions so that it will
be brought back in the same spot when it is next invoked.

11. The File IDENTIFY menu identifies the type of file and also attempts to determine if the file has any
Windows associations on record.

12. InfView HELP was vastly expanded.

13. The Status line shows the Line Number and Starting offset of the line that is currently highlighted (as
opposed to the first line in the window).

14. All Print Request options are stored in INFORMER.INI under the PRINT heading and are recalled
each time Print is invoked. (also shared with other applications).15. In Ascii view mode, double clicking on
a line in the viewer will display the Hex translation of that particular line.

16. Hex Translation Table added to Online Help for reference.

Version 1.00 - 08/15/93
1. First Version



Register this Program

This version of InfView is Unregistered. You may use this program without restriction, however we
expect (and hope) that if you like InfView that you will register the program with the authors.

To Register send a cheque or money order for $6.99 to:
Dean Software Design
P.O. Box 2331
Everett, WA 98203-0331

Note: You can register this program using the CompuServe Shareware Registery Forum (Go SWREG,
Registration id: 1414). There is no additional cost to you! and you save a Stamp and a Cheque!

Your registration will entitle you to:

1. A registered copy of the latest version of InfView.

2. Fully operational <unregistered> versions of other fine Shareware by Dean Software Design
3. Support.

Canadian orders add $0.50 for postage.

Orders from outside the U.S. and Canada please add $1.50 for postage.

Please use the following form and allow 1-2 weeks for delivery.

InfView Registration

Name:

Company:

Register to:

Address:

City\Country\Zip:

Phone\Fax:

Number of Copies:

Diskette Size:

Version: Latest Specific

Special Instructions:

Total: $

Do you have any questions or comments? Send us a letter or use EMail on CompuServe address



75240,65. We will promptly get back to you!

Disclaimer - Registration Agreement

Users of InfView must accept this disclaimer of warranty:

"InfView is supplied as is. The author disclaims all warranties, expressed or implied, including, without
limitation, the warranties of merchantability and of fitness for any purpose. The author assumes no liability
for damages, direct or consequential, which may result from the use of InfView."

InfView is a "shareware program" and is provided at no charge to the user for evaluation. Feel free to
share it with your friends, but please do not give it away altered or as part of another system. The
essence of "user-supported" software is to provide personal computer users with quality software without
high prices, and yet to provide incentive for programmers to continue to develop new products. If you find
this program useful and find that you are using InfView and continue to use InfView after a reasonable
trial period, you must register it! The registration fee will license one copy for use on any one computer
at any one time.

Commercial users of InfView must register and pay for their copies of InfView within 30 days of first use or
their license is withdrawn. Site-License arrangements may be made by contacting Dean Software Design.
In general, multiple copies of InfView can be registered at the following rates:

1-10 copies: $ 6.99 per copy

11 - 20 copies: $ 65.00 + $6.50 per copy over 10
21 -50 copies:  $120.00 + $6.00 per copy over 20
51 - 100 copies: $275.00 + $5.50 per copy over 50
101+ copies: $500.00 (site license, unlimited)

Anyone distributing InfView for any kind of remuneration must first contact Dean Software Design at the
indicated address for authorization. This authorization will be automatically granted to distributors
recognized by the (ASP) as adhering to its guidelines for shareware distributors, and such distributors
may begin offering InfView immediately (However Dean Software Design must still be advised so that the
distributor can be kept up-to-date with the latest version of InfView).

You are encouraged to pass a copy of InfView along to your friends for evaluation. Please encourage
them to register their copy if they find that they can use it.

All registers user receive free technical support for 90 days from the date of registration. Also all
registered users receive a free upgrade to the next version of this program when that version becomes
available. To report bugs, receive help and bug fixes please send a CompuServe message via
CompuServe Mail to:

Dean Software Design
[75240,65]

or, if you do not have access to CompuServe, write to us!

Definition Of Shareware

Shareware distribution gives users a chance to try software before buying it. If you try a Shareware
program and continue using it, you are expected to register. Individual programs differ on details -- some
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with printed manual.



Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all
rights, with a few specific exceptions as stated below. Shareware authors are accomplished
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases,
there are good programs and bad ones!) The main difference is in the method of distribution. The author
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific
group. For example, some authors require written permission before a commercial disk vendor may copy
their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your needs
and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your needs

easier, because you can try before you buy. And because the overhead is low, prices are low also.
Shareware has the ultimate money-back guarantee - if you don't use the product, you don't pay for it.

Shareware Products by Dean Software Design

InfView
Windows Ascii / Hex / Bmp / Pcx / Gif / Zip / Lzh File Viewer. View multiple files. No file size limit.

This MDI application will take a view 'snapshot' of any file and load it into a viewing window - Changing
the file on disk does not affect the snapshot since the entire file is in memory.

View 16 or 256 color BMP / PCX and GIF images directly next to their Ascii/Hex dump.

Lists files within Zip / Lzh compressed data sets and then calls your Zip/Lzh utility directly to decompress
specific files right into the Viewer!

Has Disk / Network file and word search that builds a search list of all files that match your search criteria
- will even look in Zip / Lzh files automatically!

Formatted printing in Ascii or Hex mode. Cut to a file or to the Clipboard. Identifies the type of file and
can execute files directly or by Windows association.

Uses IntelliLib (tm) technology to let you dynamically customize the application by selecting which DLLs
get loaded at runtime.

InfSpy

Windows Environment Spy Utility. Provides single window view of Heap, Windows, Tasks and Modules
loaded in Windows.

Provides detailed Hex dump of Heap entries with formatted printing as well as Memory usage information.

Relates Heap -> Windows -> Tasks -> Modules to one another so that you can determine the Windows
heirarchy.

Has Task Terminator and Module Unload features to 'clean up' your environment.
InfMon

Windows Environment Monitor. Allows you to set up Alarm levels for Windows Resources, Windows
Memory and up to 4 Local or Network Disk Drives.

When any of these fall below your alarm level an informative Alarm Box appears on the screen
accompanied with either a tone or a WAV file.



You can set this utility to run as a visible Resource Monitor, a Clock or as an invisible application.

Helps prevent system lock-ups or GPFs due to low Resources or Memory!
InfTerm

Windows Inactivity Monitor. This handly utility can be loaded on any standalone or network user to assist
in maintaining terminal security after standard working hours.

The user enters his working days and working hours. Infterm constantly monitors the time and after a
certain amount of inactivity after working hours, Infterm will either shut down Windows and run a Batch file
or program or Infterm will shut down Windows and reboot the PC.

This utility is not affected by screen savers and will shut down all applications including DOS sessions.

Great tool for Network administrators that do want people to stay on all night. Also great for security
administrators for the same reason!Registration Information

Please use the following form and allow 1-2 weeks for delivery.

InfView: $6.99 - No. of Copies
InfSpy: $6.99 - No. of Copies
InfMon: $6.99 - No. of Copies
InfTerm: $6.99 - No. of Copies
All 4 Utilities!: $16.99 - No. of Copies
Name:

Company:

Register to:

Address:

City\Country:

Phone\Fax:

Diskette Size:

Special Instructions:

Special Shipping: Can $0.50 Int $1.50:

Total: $










